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Abstract 
 
CHRONOS (www.chronos.org) is an NSF-funded project to develop an interactive 
network of data and tools for exploration and analysis of earth system history.  One of the 
most important steps in analysis and correlation of stratigraphic data is establishing an 
age model or line of correlation for an individual core hole or stratigraphic section.  The 
CHRONOS Age-Depth Plot (ADP) is a Java re-implementation of an earlier Macintosh 
program for plotting the ages of stratigraphic events versus depth and interactively fitting 
a line of correlation to those data.  ADP is delivered from the CHRONOS web site via 
Java WebStart and runs locally on the user’s machine, allowing access to local data files 
as well as data from the Neptune database via a GIS interface.  ADP allows the user to 
develop a line of correlation (LOC) using a palette of tools for adding, moving, and 
deleting LOC control points.  In addition, the user is able to zoom in to a more detailed 
view of different plot regions, toggle the display of different plot groups, and edit plot 
and axis titles and labeling.  Output options include saving of the LOC control point data, 
event data projected to the LOC, and of the plot itself in PNG, JPEG, or SVG (Scalable 
Vector Graphics) format.  SVG is an XML specification for describing vector graphics 
and the output SVG file is designed for convenient editing of various plot characteristics, 
with font and line characteristics for various plot elements and the palette of plotting 
symbols defined at the top of the file.  In addition to being a useful application in its own 
right, ADP serves as a prototype for other clients interfacing with the web services 
provided by the CHRONOS portal. 

1.  Introduction 

The CHRONOS Age-Depth plotting program, ADP, is a Java re-implementation of the 
ADP program written by Dave Lazarus for the Macintosh (Lazarus, 1992; Lazarus, 
1995).  As a Java program, it can run on multiple platforms (Window, Mac, 
UNIX/Linux) and can take advantage of Java’s extensive networking support to access 
data over the web.  ADP reads paleontological age-depth data from CHRONOS’s 
Neptune database or from local files, plots those data, and allows interactive fitting of a 
line of correlation or age model.  The Neptune database contains paleontological data 
from Deep Sea Drilling Project and Ocean Drilling Project holes (Spencer-Cervato, 
1999). 

 

2.  Downloading and starting the program 

ADP runs under the Java runtime environment (1.4 or higher) and is downloaded and 
launched from the CHRONOS web site (www.chronos.org) via Java WebStart.  With the 
initial download, the application is cached on your hard drive and run locally.  Thereafter, 
you can run the program offline (without an internet connection).  However, if you are 
online when you start the program, WebStart will automatically check whether an 
updated version is available from the CHRONOS website.  Of course, you will not be 
able to connect to the Neptune database if you are working offline. 

http://www.chronos.org/
http://www.chronos.org/
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3.  Reading stratigraphic data from the Neptune database 

To retrieve data from the Neptune database, select Get Neptune Data...  from the File 
menu.  In a moment, you should be presented with a world map showing locations of 
DSDP and ODP holes represented in the database.  Initially, the hole selection tool 
(pointer) is activated.  While this button is activated, you can click on the map to select 
holes near the cursor location.  The information for the selected holes will appear in the 
data table at the bottom.  When working with the map window, choose the Zoom in 
button (magnifying glass with "+") and then drag a rectangle on the map and release to 
zoom in to that region.  Then click on the pointer button to return to hole-selection mode.  
The Zoom out button (magnifying glass with "-") will automatically zoom back out to 
global extent, leaving the current mode (selection or zoom-in) unchanged.  For any 
zooming operation, there will be a bit of a pause while the code retrieves a new world 
relief image at the appropriate scale. 

 

 

 

To retrieve the data for one of the holes displayed in the data table, select the appropriate 
row in the table with a single click on any cell in that row and then click Retrieve 
Selected Data.  A text window will then appear, displaying the stratigraphic event data as 
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they are retrieved from the database.  Once the all the events for the hole are found, the 
title of the text window changes from Retrieving Neptune data...  to Neptune data 
retrieved and the plot is made.  You can get the data window out of the way either by 
closing it (click on the x in the corner) or repositioning it or by clicking on the main 
application (plot) window to bring it to the front.  Later, you can re-display the data 
window by selecting Show Data Window from the Edit menu. 

 

 

 

The data window displays data as tab-delimited fields, in the same format as a local 
stratigraphic event file (Section 12).  On most systems you should be able to select and 
copy the data and then paste them into a text editor to create a local file.  A right-click 
(Windows) or ctrl-click (Mac) on the text area should bring up an editing pop-up menu. 

The code will also attempt to retrieve an age model from the Neptune database and 
display it, along with information regarding the age model quality and the date it was 
developed (in the LOC file info line at the top of the application).  If it cannot find an age 
model for the selected hole, it will generate the default straight-line LOC connecting the 
extreme depth and age values. 
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4.  Reading stratigraphic data from local files 

To read data from local files, select Read data...  from the File menu to initiate data 
input.  You will then be presented with two dialog boxes in succession, the first asking 
you to locate and open a core-depth data file (Section 11) and the second asking you to 
locate and open a stratigraphic event data file (Section 12).  The captions at the top of 
each dialog box indicate what they are asking for, but you have to pay close attention to 
notice them. 

All ADP data files are plain text files, but the program enforces no file-naming 
conventions.  Use names that help you remember what is in each file. 

The information in the core-depth data file is used to interpret any stratigraphic event 
depths that are in core-section,cm format in the stratigraphic event data file.  However, 
the core-depth data are not required to interpret stratigraphic event depths that are already 
presented in meters below sea floor (mbsf).  You may skip input of core-depth data by 
clicking Cancel on the first dialog box.  In this case, the program will still present you 
with the stratigraphic event data file dialog box and will still read and plot events with 
depths in mbsf. 

As the stratigraphic event file is processed, the data window will show the resulting data 
values, with the depths in mbsf (rather than core-section,cm format).  Once the data have 
been processed, the plot will update.  Again, you can either close the data window or 
simply switch to the main application (plot) window by clicking on it.  The opening 
comment lines from both the core-depth and stratigraphic data files are displayed at the 
top of the application.  You should check these to make sure that you have read the files 
you intended to read. 

 

5.  Reading line-of-correlation (LOC) data 

Whenever you read in new stratigraphic event data from local files, ADP automatically 
calculates a line-of-correlation (LOC) consisting of a single straight segment connecting 
the extreme age and depth values in the dataset.  At this point you may either use the 
palette of buttons to modify the LOC or read in a previously existing LOC from a LOC 
data file (Section 12).  To do the latter, select Read LOC...  from the File menu and use 
the resulting dialog box to navigate to and open the desired LOC data file. 

Once the file is read, the program will display the LOC on the plot and will also display 
the opening comment line from the LOC file after the LOC file info label. 
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6.  Modifying the line-of-correlation 

The LOC is represented on the plot as a green line, with open green squares representing 
the control points for the line.  You may move, add, or delete points using the first three 
buttons in the palette at the left.  (Let the mouse hover briefly over a button to see a brief 
description of its function.)  The buttons work as follows: 

 

Move a control point.  When this button is activated you may use the 
mouse to grab and drag an existing control point to a new location (click 
on the point, drag, release).  Use the age-depth coordinate label at the 
bottom of the plot to keep track of the mouse location.  Once you grab a 

point, the program displays light gray lines delimiting the boundaries for a legal move for 
that point.  These boundaries prevent you from creating an age model where age 
decreases with increasing depth.  You may, however, create a hiatus by dragging the 
mouse beyond the upper or lower bounding line.  In this case, the control point will stick 
at the boundary and will be assigned the bounding depth. 

 

Add a control point.  When this button is activated you may add a control 
point with a single click on the plot.  Light gray lines delimit the legal 
locations for control point additions, again allowing only non-decreasing 
age with increasing depth. 

 

Delete a control point.  When this button is activated you may delete a 
control point by clicking on it. 

 

 

7.  Changing axis limits 

The plot's axis limits may be changed using the following three buttons. 

 

Zoom in.  When this button is activated you may zoom in to a rectangular 
region of interest by clicking and dragging out a rectangle on the plot.  (If 
you try to zoom in with just a single click, the plot region will collapse on 
itself!) 
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Zoom out.  Click this button to zoom the plot back out to the default 
limits (based on the data range). 

 

 

Change axis parameters.  Click this button to launch a dialog box 
allowing you to enter numeric values for the axis limits and tick intervals 
along each axis. 

 
 

8.  Modifying the plot 

The plot legend includes checkboxes for toggling the display of the different plot groups.  
Click in a box to remove the corresponding group from the plot and click it again to re-
display that group.   

The Edit menu contains items for modifying the main plot title and axis titles and for 
showing and hiding the stratigraphic event labels, which are short character strings read 
from the stratigraphic event data file.  Generally, event labels will overlap unless the 
density of data in the plot window is fairly low.  Lower data densities can be achieved by 
toggling plot groups off or by zooming in to a more detailed view. 

 

9.  Saving the plot 

Select Save plot...  from the File menu to save the current plot to a file.  The current 
format options for the output file are SVG (Scalable Vector Graphics), PNG, and JPEG.  
The latter two options use Java's Robot and ImageIO packages to generate an automatic 
screen capture of the plot region and write the image to a file.  Thus, the output file will 
contain a raster image of plot region as you see it on the screen (meaning you need to get 
the data window and other extraneous objects out of the way before using this option).  
SVG is an XML specification for describing vector graphics and the output SVG file (a 
plain text file) is designed for convenient editing of various plot characteristics, with font 
and line characteristics for various plot elements and the palette of plotting symbols 
defined at the top of the file. 
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10.  Saving data 

Use the Save projected data...  item on the File menu to write out a file containing the 
stratigraphic event data projected to the LOC.  You will be asked to enter your name or 
initials and then a header line comment, both of which will be written to the output file.  
Then you will be presented with a standard dialog box for specifying the location and 
name of the output file. 

The projection consists of replacing the input age value(s) for each event with the ages on 
the LOC corresponding to the minimum and maximum depth for that event.  The data file 
will be written in the same format as an input stratigraphic data file, meaning you can 
read the projected data back in and diplay them.  All the depths in the output file will be 
in mbsf, so you do not need a core-depth data file to interpret a projected stratigraphic 
event data file. 

Use the Save LOC...  item to write out the current LOC data to a file.  In this case you 
only get the "save file" dialog box.  The first line of the LOC file will contain the hole id 
and the current date. 

11.  Core-Depth data file format 

The core-depth data file specifies the depth range, in meters below sea floor (mbsf), for 
each core obtained from a sample hole.  It should be a tab-delimited plain text file with 
two lines of header information, as in the following example: 

278 2.00   19910225 1 Extracted from CD-ROM 
CORE TOP DEPTH BOTTOM DEPTH OR BASE RECOVERED SEDS 
1  0   6 
2  101   110.5 
3  110.5   119.5 
4  120   127.5 
5  129.5   138.5 
6  139   148.5 
7  148.5   157.8 
8  158   167.5 
9  167.5   176 
    

This file follows the format of the DSDP and ODP core-depth files used in the original 
(Macintosh) ADP.  The five tab-delimited fields in the first line represent the hole ID, a 
program version number, a date, a file type number, and a comment.  The Java version of 
ADP extracts the hole ID from the first field and displays the entire line following the 
Core file info label at the top of the application.  However, after extracting the hole ID, 
the code does not try to parse the line any further, so the remainder of the line could 
really contain anything.  If you are preparing an input file, use this line to convey the hole 
ID and any other helpful information regarding the data provenance. 
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The second line contains headers for the three columns of data.  Java ADP simply skips 
over this line, so its contents have no effect on program operation. 

The third and following lines should contain core number, top depth (mbsf), and bottom 
depth (mbsf) for each core.  The cores do not have to be listed sequentially and gaps (no 
core 6, for example) are allowed. 

 

12.  Stratigraphic data file format 

The stratigrpahic event data file should be a tab-delimited plain text file containing 
identifying information, age, and depth values for the events (samples) in a core hole.  
Event depths may be specified directly as numbers, which are taken to be meters below 
sea floor (mbsf) or may be entered in core-section,cm format.  Events may be assigned 
either a single age or an age range (minimum to maximum) and similarly either a single 
depth or a depth range.  The opening lines of an example data file follow:  

278 2 5/7/91 CSC Schrader 113+119+120  
Grp Event        Plotcode Y.  Age Old Age Top depth Bottom depth 
D FAD N.  curta    bNc 3.64  "16-4,50" "16-5,50" 
D FAD A.  parvulus   bAp 4.58  "29-4,50" "29-6,50" 
D LAD N.  donahuensis tNd 5.84  "9-3,50" "9-4,50 " 
D FAD N.  donahuensis bNd 9.64  "12-2,50" "12-3,50" 
D FAD H.  karstenii bHk 9.64  "10-6,50" "11-1,50" 
    

Like the core-depth data file, this file follows the format of the stratigraphic event files 
used in the original (Macintosh) ADP.  The fields in the first line represent the hole ID, a 
program version number, a date, initials of the creator of the file, and some comments.  
The Java version of ADP displays this line following the Strat file info label at the top of 
the application, but does not try to process the line in any way, so its contents do not 
influence program behavior. 

The second line contains headers for the seven columns of data, as a convenience for the 
human reader.  The code skips over this line, so its contents are not crucial. 

The third and following lines contain the data.  Each line should contain seven tab-
delimited fields, as follows: 

• Group code: A character string (one or more characters) distinguishing and 
identifying different groups of data, e.g., R for radiolarian, D for diatom, etc.  
Each group is plotted with a different color and symbol. 

• Event name: A character string identifying the event.  This will be displayed 
following the Event label at the bottom of the application whenever the cursor is 
over that event. 

• Plot code: A shorter character string intended as a plotting label for the event.  
This is not currently used by the program. 
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• Minimum age: Minimum age for the event or the single age for the event, if the 
maximum age field is empty. 

• Maximum age (optional): Maximum age for the event.  If this field is empty 
(meaning there are two consecutive tabs between the minimum age and minimum 
depth fields), then the sample will be assigned the minimum age.  Events with 
both a minimum and maximum age will be plotted with a horizontal line 
representing the age range and with the plotting symbol at the midpoint of the 
range. 

• Minimum depth: The minimum or top depth for the event or the single depth for 
the event, if the maximum depth field is empty.  Depths may be in mbsf or may 
be specified in core-section,cm format.  Depths in core-section,cm format may be 
enclosed in double quotes but the quotes are not required. 

• Maximum depth (optional): The maximum or bottom depth for the event.  This 
may be in mbsf or core-section,cm format.  If this field is empty, then the 
minimum depth will be used as the single depth for the event.  Events with both a 
minimum and maximum depth will be plotted with a vertical line representing the 
depth range and with the plotting symbol at the midpoint of the range. 

Interpreting depths in core-section,cm format 

Depths may be specified in core-section,cm format like "5-3,40" (the hyphen and comma 
are the required delimiters).  This means 40 cm below the top of section 3 in core 5.  The 
program assumes that each core is divided into consecutive 1.5-meter sections, so that the 
top of section 3 is 3.0 meters below the top of core 5.  If the top of core 5 is at 60.0 mbsf, 
then the sample depth in this case is 60.0 + (3-1)*1.5 + 0.40 = 63.4 mbsf. 

Depths may also be specified as core-catcher samples.  For example, you could use "7-
CC" to specify core-catcher samples for core 7.  Core-catcher samples are assigned to the 
bottom depth of the core. 

Clearly the core-depth data are required to interpret depths in core-section,cm format.  If 
you cancel reading of the core-depth data file, then only events with depths given in mbsf 
will be displayed on the plot. 

13.  LOC data file format 

The line-of-correlation (LOC) data file simply contains a sequence of age-depth pairs in 
two tab-delimited columns, preceded by three header lines, as follows: 

278 19960813 
AGE DEPTH 
 11  
 9.08219e-2   .755  
 1.99553   167.976  
 9.20918   167.976  
 11.2385   205.645  
 15.8344   269.155  
 19.0417   321.457  
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 19.875   344.554  
 24.2917   344.554  
 30.0833   412.402  
 35.5417   412.402  
 36.375   424.672  
    

The program will display the contents of the first header line following the LOC file info 
label at the top of the application but does not try to process the line, so its contents are 
immaterial to program operation.  The header line in the example above contains a hole 
ID and a date. 

The second line contains headers for the two columns of data and the third line gives the 
number of data lines to follow.  The third line is retained for consistency with LOC data 
files for the original ADP program.  However, the code actually skips over these lines 
without processing them and will just read data lines until it reaches the end of the file. 

The third and following lines should contain tab-delimited age and depth values, both in 
increasing (or at least non-decreasing) order.  These values represent the control points of 
the LOC.  A hiatus is represented by two consecutive ages with the same depth.  It is also 
allowed to have two consecutive depths with the same age, but age may not decrease with 
increasing depth. 
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